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About Installing IBM Network Station Manager for AS/400
(SC41-0684)

Who should read this book
This information is intended for the person who is installing and administering the
IBM Network Station Manager.

Information available on the World Wide Web
You can obtain the latest version of this book on the World Wide Web from the
following URL: http://www.ibm.com/nc/pubs This is the same URL that is printed
on the cover of this book.

Related information
The following information is available for the IBM Network Station Manager
product:

Information name Information description

Installing IBM Network Station
Manager for AS/400, SC41-0684

Describes the installation and simple configuration of an
AS/400 Network Station environment. It is shipped with
the IBM Network Station Manager licensed program.
Updates to this information are at
http://www.ibm.com/nc/pubs.

Installing IBM Network Station
Manager for RS/6000, SC41-0685

Describes the installation and simple configuration of an
RS/6000 Network Station environment. It is shipped
with the IBM Network Station Manager licensed
program. Updates to this information are at
http://www.ibm.com/nc/pubs.

Installing IBM Network Station
Manager for Windows NT, SC41-0688

Describes the installation and simple configuration of a
Windows NT Network Station environment. It is shipped
with the IBM Network Station Manager licensed
program. Updates to this information are at
http://www.ibm.com/nc/pubs.

Using IBM Network Station Manager,
SC41-0690

Describes the basic tasks for managing user desktops
through the IBM Network Station Manager program. It
is shipped with the IBM Network Station Manager
licensed program. Updates to this information are at
http://www.ibm.com/nc/pubs.

IBM Network Station Advanced
Information

Describes tasks and information beyond a basic
installation and configuration of your Network Station
environment. This information is only available at
http://www.ibm.com/nc/pubs.

IBM Network Station Manager help text Describes the basic how-to tasks for configuring your
Network Station desktop appearance. This information is
availble by clicking the help icon in the IBM Network
Station Manager program.

Desktop help Describes how to use and operate the Network Station
desktop. This information is available by clicking the
help icon in the lower right of the Network Station
desktop.
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How to send your comments
Your feedback is important in helping to provide the most accurate and
high-quality information. If you have any comments about this book or any other
documentation, fill out the readers’ comment form at the back of this book.
v If you prefer to send comments by mail, use the readers’ comment form with the

address that is printed on the back. If you are mailing a readers’ comment form
from a country other than the United States, you can give the form to the local
IBM branch office or IBM representative for postage-paid mailing.

v If you prefer to send comments by FAX, use either of the following numbers:
– United States and Canada: 1-800-937-3430
– Other countries: 1-507-253-5192

v If you prefer to send comments electronically, use this network ID:
– IBMMAIL, to IBMMAIL(USIB56RZ)
– RCHCLERK@us.ibm.com

Be sure to include the following:
v The name of the book.
v The publication number of the book.
v The page number or topic to which your comment applies.
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IBM Network Station overview
The IBM Network Station Manager licensed program code is made up of several
programs that are installed on a server. One of these programs is the IBM Network
Station Manager program. The IBM Network Station Manager program allows you
to set and change configurations for IBM Network Station thin clients (hereafter
referred to as Network Stations) and Network Station users through a Web
browser. See the Using IBM Network Station Manager book for more information
about the IBM Network Station Manager program.

Since the Network Station does not contain a hard drive, the Network Station
accesses the server to download the client operating system, client programs, and
data. After the Network Station loads the client operating system, the Network
Station displays a graphical user interface (GUI). The GUI can provide the user
access to the following kinds of resources:
v 5250 emulator application
v 3270 emulator application
v Telnet application
v Web browser application (Netscape Communicator)
v Java applets or applications
v Windows-based applications
v Local and remote printers

The Network Station communicates using Transmission Control Protocol/Internet
Protocol (TCP/IP) over a token-ring or Ethernet connection to the server. Each
Network Station runs the client operating system and communicates to a server
that runs the IBM Network Station Manager program and other application
programs.

Figure 1 on page 2 shows what happens when you power on an IBM Network
Station.
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�1� A non-volatile random access memory (NVRAM) resident program starts. The
Network Station automatically runs a series of power-on self tests (POST).

�2� The Network Station contacts a BOOTP or DHCP boot server. The Network
Station exchanges its media access control (MAC) address for the IP address that is
provided by the server. The boot server also provides the address or path of the
base code server. The Network Station may alternatively retrieve this information
from values that are stored in its NVRAM.

�3� The Network Station downloads the base code from the base code server using
trivial file transfer protocol (TFTP) or network file system (NFS).

�4� The Network Station downloads the workstation-based configuration
information from the workstation configuration server.

�5� The Network Station presents a logon screen. When the user enters a user id
and password, the authentication server verifies the user’s identification.

�6� The user’s configuration server downloads and initiates the personalized
environment preferences of the user.

�7� The Network Station displays the personalized desktop of the user. The user is
able to access application programs that reside on the application server (or host
computer).

Each Network Station contains a simple network management protocol (SNMP)
agent as part of its operating system. An SNMP manager at a central location can
communicate and exchange information with the agent on a Network Station. You

Figure 1. Network Station power-on sequence
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can use this information to manage your network environment. SNMP is an
industry-standard protocol for network management. See IBM Network Station
Advanced Information for more information about SNMP. You can find this
document at http://www.ibm.com/nc/pubs.

Each Network Station can display the IBM Network Station Setup Utility or IBM
Network Station NS Boot utility. The Setup Utility or NS Boot utility allows you to
View or Set (change) configuration settings on a particular Network Station. For
example, you can view the MAC address or you can set the monitor resolution of
the Network Station. See Using IBM Network Station Manager for more information
about the Setup Utility and NS Boot Utility.

TCP/IP overview
In order for the Network Station to communicate with your servers, you need a
TCP/IP network. If you understand your TCP/IP network, installing and
configuring your Network Station and IBM Network Station Manager program is
much easier. To help understand your network, draw a diagram of your network.

Refer to the network examples in this section to help you understand how to
configure your network. Choose the network example that most closely resembles
your network diagram. Refer to these examples as you go about configuring and
installing Network Stations on your network.

Note: You do not need to be an expert in order to set up a TCP/IP network.
However, you should have an understanding of basic TCP/IP. A detailed
introduction to TCP/IP is beyond the scope of this book. If you need to
improve your understanding of TCP/IP, you can contact your IBM sales
representative, who has information about classes in your area. You may
also want to refer to the redbook, TCP/IP Tutorial and Technical Overview,
GG24-3376.

LAN network examples

LAN network example 1
Figure 2 on page 4 shows an example of a network diagram in which two Network
Stations are connected over a simple local area network (LAN).
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LAN network example 2
Figure 3 shows an example of a network diagram in which two Network Stations
are connected to the server over a local LAN. Two more Network Stations connect
to the server through a router over a remote LAN.

LAN network example 3
In Figure 4 on page 5, additional Network Stations connect to the server by using
Ethernet connections and token-ring connections. Two token-ring LANs connect
via a router. A Domain Name Server also connects to the network.

Figure 2. Two Network Stations connected to the server over a simple LAN

Figure 3. Two Network Stations connected to the server over a local LAN and two Network
Stations connected to the server through a router over a remote LAN

4 Installing IBM Network Station Manager for AS/400 V2R1



MAC addresses
Every Network Station comes with a unique identifying number that can be used
to keep track of which IP address has been assigned to it. Media access control
(MAC) addresses of each Network Station are assigned by manufacturing and
hard-coded into the machine. The MAC address of a Network Station is on the
side panel of the small box in which the logic unit is packaged. If you no longer
have the box, see the Using IBM Network Station Manager book for instructions on
how to find the MAC address.

You can override the hard-coded MAC address with a customer-assigned MAC
address. See Using IBM Network Station Manager for instructions on how to
override the hard-coded MAC address.

IP addresses
Internet Protocol (IP) addresses are numbers that are assigned to devices on a
network (or on the Internet). IP addresses allow computers to communicate
through TCP/IP. IP addresses consist of four numbers (from 0 to 255) that are
separated by periods, for example 192.168.1.1. The numbers that are separated by
periods indicate the network to which a computer belongs and the specific location
of the host computer within that network.

IP addresses are not just for computers such as Network Stations, but also for
routers, servers, and even subnets and networks themselves. For example, the IP
address of a network might be 192.168.1.0. A router on that network might use the
IP address 192.168.1.1. A Network Station on the same network might have the
address 192.168.1.145.

Figure 4. Four Network Stations connected to a network using a router and a domain name
server
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Each Network Station must have a unique IP address. If you are using the DHCP
boot method, you must specify a range of IP addresses so that the server can
assign an address to each Network Station. For intranets (networks within your
own organization), you can assign your own addresses. However, if you want to
connect to the Internet, a central authority must officially assign the network
addresses and domain names. At the time of this writing, the authority is as
follows:
Network Solutions, Inc.
InterNIC Registration Services
505 Huntmar Park Drive
Herndon, VA 22070
1-703-742-4811
E-mail: hostmaster@internic.net
WWW: http://rs.internic.net

Boot methods
Since a Network Station has no disk from which to start, it must request
information either from its own non-volatile random access memory (NVRAM) or
from a server. The Network Station needs to find an IP address for itself. The IP
address allows the Network Station to communicate with other hosts. The
Network Station can use one of the following methods to request and receive this
information:
v Dynamic Host Control Protocol (DHCP)
v Bootstrap Protocol (BOOTP)
v Non-Volatile Random Access Memory (NVRAM)

BOOTP servers can only respond to BOOTP clients, but DHCP servers can respond
to both BOOTP and DHCP clients.

Note: If you use the BOOTP or DHCP boot methods, you must configure all
routers and gateways in your network to send and receive BOOTP or DHCP
packets. If you cannot configure your routers to be BOOTP or DHCP relay
agents, you could do either of the following:
v Use a system that has the necessary configuration support to receive

limited BOOTP or DHCP broadcasts. Then forward those broadcasts to
the appropriate server.

v Use the NVRAM boot method for those Network Stations that are behind
a router that cannot forward BOOTP or DHCP broadcasts.

DHCP
Dynamic Host Configuration Protocol (DHCP) is a TCP/IP protocol. DHCP
provides a way for a server to automatically allocate IP addresses and
configuration information without forcing the administrator to record and track the
MAC addresses of the networked computers. DHCP is capable of assigning either
a permanent IP address or a temporary IP address for every host or Network
Station within a predetermined range of IP addresses. You can also use DHCP to
assign IP addresses either statically or dynamically.

In static IP address assignment, you define the MAC address of every Network
Station in the DHCP server configuration along with an IP address, which is
reserved for the Network Station with this MAC address. A Network Station,
identifying itself by its MAC address, sends a request to the DHCP server. The
server then returns the IP address that it has reserved for that client.
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In dynamic IP address assignment, the server still identifies a Network Station by
its MAC address. However, instead of using a fixed IP address, the server allocates
any address out of the available pool. The server leases the address to the Network
Station for a specified period of time. The address returns to the pool either when
the client releases it or when the lease runs out.

DHCP can allow for unlisted clients. Any client, even one with an undefined MAC
address in the DHCP configuration, may request an IP address from the pool of
available addresses. The use of unlisted clients might be appropriate in an
environment in which it is not necessary or preferable to keep track of MAC
addresses.

While BOOTP servers can handle requests only from BOOTP clients, DHCP can
handle requests from both DHCP and BOOTP clients.

DHCP servers (unlike BOOTP servers) can reuse IP addresses that are not currently
being used.

Finally, DHCP provides a large set of configuration options that may include
user-defined options. These options are useful in configuring advanced network
environments. See IBM Network Station Advanced Information for a more in-depth
discussion of advanced network environments. You can find this document at
http://www.ibm.com/nc/pubs.

BOOTP
Bootstrap protocol (BOOTP) is a TCP/IP protocol that allows the Network Station
to request an IP address and the location of the base code file from a server.

To use the BOOTP boot method, the network administrator must record the MAC
addresses of all the Network Stations on the network. Then the network
administrator assigns each of them an IP address. The administrator then enters
those assignments on a BOOTP table. When you need to change IP addresses, you
can do so centrally on the table in the boot server rather than individually on each
Network Station.

When a Network Station powers on, it broadcasts its MAC address to the BOOTP
server. The server looks up the IP address of the Network Station according to its
MAC address. BOOTP then returns a reply that assigns the IP address for the
Network Station and the name and location of the base code file.

Because BOOTP assigns IP addresses statically (fixing an IP address according to a
computer’s MAC address and then recording this assignment), it is less versatile
than DHCP.

NVRAM
Non-Volatile Random-Access Memory (NVRAM) refers to local Network Station
memory. When you use the NVRAM boot method, you code the IP addresses of
the Network Station and its server into the memory of the individual Network
Station. The Network Station powers on and requests the download of the base
code file from the server.

The NVRAM boot method is most practical in small, stable networks. You may
also choose to use the NVRAM boot method for one of the following reasons:
v As a method to avoid routers that block BOOTP and DHCP broadcast requests.

BOOTP and DHCP broadcast requests for IP addresses can create unnecessary
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traffic on the network. Many network routers are configured not to pass these
broadcast requests. Since NVRAM does not need to request its IP address
(because it has been entered in the NVRAM of the Network Station), it does not
make broadcasts.

v As an aid in finding and correcting problems with network connections.
v As an aid in finding and correcting problems with BOOTP or DHCP

configurations.

This method may not work well for larger networks for the following reasons:
v You must enter setup data into each Network Station manually.
v DHCP and BOOTP can configure many more parameters that may not be easily

configured with this method.

For information about how to configure NVRAM in the Setup Utility or NS Boot
utility, see the Using IBM Network Station Manager book.

Boot file service
The Network Station uses TFTP to receive the base code file from the base code
server. Trivial file transfer protocol (TFTP) is a simple protocol that is used to
transfer files.

Java on the Network Station
Java is a programming language that is designed to bridge the gap between
different platforms. Java’s imperative, ″Write once, run anywhere,″ refers to its
portability and to the ability of a single Java program to run on different platforms.
To view Java applications, you need a bundle of Java-enabling programs called
Java Virtual Machine (JVM). Using JVM on diskless clients such as the Network
Station allows the user to access applications without using permanent disk space
either on the Network Station or on the server.

There are two kinds of Java programs:
v Applets — require a browser or applet viewer
v Applications — display directly

The first variety, applets, rely on a browser or applet viewer to provide windows
and graphical layout. In general, the browser does not “trust” applets because they
are downloaded across the Internet. In other words, the browser can restrict
applets from reading or writing to local files and from connecting to machines
other than those from which they are downloaded. These restrictions protect users
from virus-contaminated programs and provide a safe environment for examining
programs on the Internet.

See IBM Network Station Advanced Information for more information about Java. You
can find this document at at http://www.ibm.com/nc/pubs.

Windows applications on the Network Station
Network Stations can run Windows-based applications through the use of a
multi-user Windows server. There are several products that can provide a
multi-user Windows server:
v Citrix WinFrame is a multi-user Windows application server that is based on

Windows NT 3.51. Citrix WinFrame communicates to the Network Station by
using the independent computer architecture (ICA) protocol.
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v NCD WinCenter is a multi-user Windows application product that requires
Citrix WinFrame or Microsoft Windows NT Server 4.0, Terminal Server Edition.
NCD WinCenter communicates to the Network Station by using the X11
protocol.

v Citrix MetaFrame is a multi-user Windows application product that requires
Microsoft Windows NT Server 4.0, Terminal Server Edition. Citrix MetaFrame
communicates to the Network Station by using the ICA protocol.

Network Stations that start from a V1R3 or V2R1 IBM Network Station Manager
licensed program server can communicate to a multi-user Windows server using
the X11 protocol or the ICA protocol.

For more information, see the following Web sites:
v WinFrame and MetaFrame - http://www.citrix.com
v WinCenter - http://www.ncd.com
v Windows NT Server 4.0, Terminal Server Edition - http://www.microsoft.com

Network Station memory requirements
Network Stations download each of their applications into memory. You should
verify that your Network Stations have enough memory to run their applications.
For more information on memory, do the following:
1. Go to this Web site: http://www.ibm.com/nc
2. Select your country and select Go.
3. In the left frame, click on Support.
4. In the Search field, enter memory requirements.

Taking advantage of multiple server environments
You can install the IBM Network Station Manager licensed program on multiple
computer systems. For a more in-depth discussion of this topic, see the IBM
Network Station Advanced Information. You can find this document at
http://www.ibm.com/nc/pubs.

New features in Version 2 Release 1
Version 2 Release 1 (V2R1) of the IBM Network Station Manager licensed program
introduces many new features. These features include:

Client desktop
The client desktop has a new look and includes the following:
v 16-bit color support
v Scalable fonts
v Desktop help
v Kiosk mode

For more information, see the Using IBM Network Station Manager book.

Netscape Communicator 4.5
Netscape Comunicator 4.5 includes the Navigator browser, and Messenger
(e-mail and news). The browser is fully compatible with other Unix
versions of Netscape Navigator. Key features that are new in this version
include:
v Netscape JVM
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v Runtime Plug-in for the Network Station, Java Edition
v PDF helper application
v Real Player helper application
v Audio player helper application
v Video player helper application

For more information, see the Using IBM Network Station Manager book.

Windows application support
Enhanced ICA support. For more information, see the Using IBM Network
Station Manager book.

VT emulator
Enhanced VT emulator. For more information, see the Using IBM Network
Station Manager book.

Productivity applications

v File manager
v Text editor
v Calendar
v Calculator
v Paint

For more information, see the Using IBM Network Station Manager book.

Java The IBM Network Station Manager licensed program provides two JVMs:
v Netscape 4.5 JVM
v IBM JVM (JDK 1.1.8)

Flash memory support
Flash memory support provides the ability to local boot from a flash
memory card and a flash memory management utility. For more
information, see IBM Network Station Advanced Information. You can find
this document at http://www.ibm.com/nc/pubs.

Hardware support

Table 1 shows the IBM Network Station hardware by machine type, model
number, and series. It also shows which version and release of the IBM
Network Station Manager licensed program is required to support a
particular hardware machine type and model.

For example:
v Machine type 8364 model Exx requires V2R1
v Machine type 8362 model A22 is supported by either V2R1 or V1R3

Table 1. IBM Network Station hardware types, models, and series

Compatible
release

Machine type - model

Series 100 Series 300 Series 1000 Series 2200 Series 2800

V2R1 only 8363-Exx

8363-Txx

8364-Exx

8364-Txx
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Table 1. IBM Network Station hardware types, models, and series (continued)

Compatible
release

Machine type - model

Series 100 Series 300 Series 1000 Series 2200 Series 2800

both V2R1 and
V1R3

8361-110

8361-210

8362-A22

8362-A23

8362-A52

8362-A53

V1R3 only 8361-100

8361-200

8361-341*

* Twinaxial model supported only on AS/400 servers.

Coexistence with V1R3
When you install V2R1 on a system that already has V1R3 installed on it,
the V1R3 environment is preserved. Both V2R1 and V1R3 can coexist and
operate on the same server. The ability to have two software versions that
coexist on the same server allows support for all Network Station
hardware models. A migration utility can migrate the V1R3 preference files
to V2R1. You can uninstall the V1R3 environment after you migrate the
V1R3 preference files. For more information, see “Chapter 4. Migrating
from V1R3 to V2R1” on page 43.
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About this chapter
This chapter contains instructions for preparation, installing and configuring an
IBM Network Station environment on an AS/400 server. While completing the
installation procedure and the configuration procedure, do not deviate from the
order of the steps.

Installing IBM Network Station Manager licensed program
This section describes the preparation and installation of the IBM Network Station
Manager (5648-C07) licensed program.

Attention:

v If you have manually changed any configuration files instead of using the IBM
Network Station Manager in the past, go to http://www.ibm.com/nc/pubs for
Advanced User Information.

v The Series 2800 (Type 8364) Network Station supports multiple software releases.
For information on the best way to set up Series 2800 (Type 8364) Network
Stations for V2R1 IBM Network Station software, you must see ″Running V2R1
on Series 2800″ in the latest V2R1 information on the web.
1. Go to http://www.ibm.com/nc/.
2. Select your country and click Go.
3. In the left frame, click Support.
4. In the Search field, specify ’Running V2R1 on Series 2800’ and click Go.

To install the IBM Network Station Manager (5648–C07) licensed program, do the
following:
__ 1. If you have a previous release of IBM Network Station Manager installed

on your server, you must read the information in “Chapter 4. Migrating
from V1R3 to V2R1” on page 43 before you continue.

__ 2. For the latest V2R1 information, a list of required product temporary fixes
(PTF) and other important information do the following:
a. Go to http://www.ibm.com/nc/.
b. Select your country and click Go.
c. In the left frame, click Support.
d. In the Search field, specify ’PTF’ and click Go.
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Review this list to see the latest information and required PTFs. The
application of these PTFs prevents unpredictable results including
possible data loss.

__ 3. To determine which PTFs you should order based on the PTFs already
installed, you can run Display Program Temporary Fix (DSPPTF). At an
AS/400 command line, type DSPPTF.

__ 4. Verify prerequisite hardware and software
Your AS/400 server must meet the following minimum software
requirements:
v OS/400 Version 4 Release 2 (5769–SS1 with the installation of option 12 )
v OS/400 TCP/IP Connectivity Utilities (5769-TC1)
v For V4R3 and later, IBM HTTP Server for AS/400 (5769–DG1)
v A PC with V4R4 Client Access Express for Windows (5769–XE1) service

pack 1 (SPF1)

Note: Please check Informational APAR II11759 for the latest list of
OS/400 PTFs. You must install the latest PTFs on the AS/400 prior
to attempting any Client Access functions. If the required OS/400
PTFs are not installed on the AS/400, some of the fixes in this
service pack will not work. You can view Informational APARs for
Client Access on the internet at
http://www.as400.ibm.com/clientaccess/ under the ″Information
APARs″ link.

For Client Access Express ordering information, visit the same web
location.

v The Network component of AS/400 Operations Navigator
v You must configure the AS/400 NetServer. To configure the AS/400

NetServer, see the Client Access Express For Windows – Setup hard copy
book (SC41–5507). For additional information on the NetServer see the
Info Center at http://www.as400.ibm.com/infocenter. Choose Information
Center and the version and release. Then look under Networking.

__ 5. Verify the memory requirements for your Network Stations
Network Stations download each of their applications into memory,
including their base systems. You should verify that your Network Stations
have enough memory to run their applications.
a. Go to http://www.ibm.com/nc/.
b. Select your country and click Go.
c. In the left frame, click Support.
d. In the Search field, specify ’Memory Requirements’ and click Go.

__ 6. Verify your security authority
Your user profile must have the following authorities:
v *SECADM
v *ALLOBJ
v *IOSYSCFG
v *SECOFR (to run the migration utility)

To check your security authorities, you can use the Display User Profile
(DSPUSRPRF) command. At the AS/400 command line, type the following
command to view your user profile:
DSPUSRPRF youruserid
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__ 7. With the information you obtained in step 2 on page 13, apply the group
PTF to your AS/400
__ a. At an AS/400 command line, type GO PTF.
__ b. Select option 8. The display for the Install Options for Program

Temporary Fixes appears.

Install Options for Program Temporary Fixes
System: AS400TEST

Type choices, press Enter.

Device . . . . . . . . . Name, *SERVICE

Automatic IPL . . . . . . N Y=Yes
N=No

Restart type . . . . . . *SYS *SYS, *FULL

PTF type . . . . . . . . 1 1=All PTFs
2=HIPER PTFs and HIPER LIC fixes

only
3=HIPER LIC fixes only
4=Refresh Licensed Internal Code

Other options . . . . . . N Y=Yes
N=No

F3=Exit F12=Cancel

__ c. Enter the device name where the PTF CD is located (OPT01).

Note: You may receive a message that no PTFs were installed. This message
means that your operating system did not need any PTFs. Also, you
may have received messages that some PTFs did not install. You can
ignore these messages, because they pertain to the PTFs that are not
pertinent to your system.

__ 8. If PTFs were installed, perform an IPL
Because of the PTFs you just installed, you must perform an IPL for the
AS/400 system before you install the Network Station Manager licensed
program. You must perform this step for the Network Station Manager
program to function correctly.
__ a. Ensure that the system IPL mode is in the normal mode.
__ b. Use the Power Down System (PWRDWNSYS) command to perform

the IPL. At an AS/400 command line, type
PWRDWNSYS *IMMED RESTART(*YES) IPLSRC(B)

__ 9. If TCP/IP is active, you must end the HTTP server. At an AS/400 command
prompt, type ENDTCPSVR *HTTP. You cannot complete this procedure while
the HTTP server is active.

__ 10. Install the IBM Network Station Manager licensed program (5648-C07)
The IBM Network Station Manager licensed program is available for
AS/400 systems with the a minimum operating system of V4R2.
__ a. Insert the compact disc (CD) that contains the Network Station

Manager licensed program into your AS/400 CD drive.
__ b. Install the licensed program.

To install a new licensed program, use the Restore Licensed Program
(RSTLICPGM) command. At the AS/400 command line, type:
RSTLICPGM LICPGM(5648C07) DEV(OPT01) OPTION(*BASE)
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__ c. Verify that the restore was successful.
Use the Display Job Log (DSPJOBLOG) command to view the
AS/400 job log.
1) At the AS/400 command line, type DSPJOBLOG

2) Look for any installation errors and take the appropriate action.
__ 11. The following information is to support Series 300 and 1000 machines.

To install the Power PC (ppc) component of the product, type the following
command on the AS/400 command line:
RSTLICPGM LICPGM(5648C07) DEV(OPT01) OPTION(1)

Note: If your server’s primary language is not the language you wish to
install, then specify:
LNG (language number)

on the RSTLICPGM command.

As part of the Network Station Manager licensed program, the install
program automatically installs the:
v 40-bit NC Navigator browser
v Independent Computing Architecture
v Secure Sockets Layer.

__ 12. Apply the PTFs for the IBM Network Station Manager licensed program.
This is necessary only if you found required PTFs for the IBM Network
Station Manager licensed program in step 2 on page 13.
To avoid an unnecessary IPL, you must follow these steps in the exact
order they are presented.
__ a. With the information you obtained in 2 on page 13, apply the

required PTFs to your AS/400.
__ b. At an AS/400 command line, type GO PTF.
__ c. Select option 8. The display for the Install Options for Program

Temporary Fixes appears.

Install Options for Program Temporary Fixes
System: AS400TEST

Type choices, press Enter.

Device . . . . . . . . . Name, *SERVICE

Automatic IPL . . . . . . N Y=Yes
N=No

Restart type . . . . . . *SYS *SYS, *FULL

PTF type . . . . . . . . 1 1=All PTFs
2=HIPER PTFs and HIPER LIC fixes

only
3=HIPER LIC fixes only
4=Refresh Licensed Internal Code

Other options . . . . . . Y Y=Yes
N=No

F3=Exit F12=Cancel

__ d. In the Device field, specify OPT01.
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__ e. In the Automatic IPL field, select N, because you do not need to IPL
your system after applying these PTFs.

__ f. In the Other options field, select Y. The Other Install Options display
appears.

Other Install Options
System: AS400TEST

Type choices, press Enter.

Omit PTFs . . N Y=Yes, N=No

Apply Type . . 3 1=Set all PTFs delayed
2=Apply immediate, set delayed PTFs
3=Apply only immediate PTFs

F3=Exit F12=Cancel

__ g. In the Apply Type field, enter option 3.
__ h. Press the Enter key.

__ 13. Install optional software
The following describes the installation of the 128-bit licensed program
(5648-C08) as optional software for your Network Stations.
__ a. Insert the CD that contains the Strong Encryption Support for IBM

Network Station Manager V2 licensed program (5648–C08) into your
AS/400 CD drive.

__ b. Install the licensed program.
To install a new licensed program, type the following command on
an AS/400 command line:

RSTLICPGM LICPGM(5648C08) DEV(OPT01) OPTION(*BASE)

__ c. Verify that the restore was successful.
Use the DSPJOBLOG command to view the AS/400 job log. Look for
any installation errors and take the appropriate action.

__ 14. The following information is to support Series 300 and 1000 machines.
To install the Power PC (ppc) component of the product, type the following
command on the AS/400 command line:
RSTLICPGM LICPGM(5648C08) DEV(OPT01) OPTION(1)

.

Note: If your server’s primary language is not the language you wish to
install, then specify
LNG (language number)

on the RSTLICPGM command.
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After installation of the ppc component, all users will have strong
encryption support.

Note: Your system will revert back to the 5648C07 licensed program if you:
v Installed the 5648C07 licensed program, then
v Installed the 5648C08 (strong encryption support) licensed

program, then
v Choose to delete the strong encryption support.

As part of the optional licensed program, the install program automatically
installs the:
v 128-bit NC Navigator browser
v Independent Computing Architecture
v Secure Sockets Layer.

__ 15. Installation completed
You have installed all the required software for the IBM Network Station
Manager licensed program. Continue to “Configuring your AS/400
environment for Network Stations” to configure your TCP/IP environment
and boot server.

Configuring your AS/400 environment for Network Stations
This section describes how to configure the AS/400 environment for your Network
Stations. You must have completed “Installing IBM Network Station Manager
licensed program” on page 13 before using this section. To complete the installation
and configuration for your IBM Network Stations, you must install and run the
IBM Network Station Setup Wizard.

Installing the Network Station Setup Wizard on your PC
Make sure that the AS/400 NetServer is ’started’ as follows:
__ 1. Close any other Operations Navigator windows.
__ 2. Open the AS/400 Operations Navigator main window.
__ 3. Expand the view for your AS/400 system.
__ 4. Expand the Network, then Server objects.
__ 5. Double-click TCP/IP.
__ 6. In the right frame, look for AS/400 NetServer and check that the status is

Started.
__ 7. If the status is ’Stopped’:

a. Right-click the AS/400 NetServer

b. Choose Start.
__ 8. Close Operations Navigator.

Use Client Access Selective Setup to add the component for the Network Station
Setup Wizard to Operations Navigator:
__ 1. From the desktop launch bar, click Start=>Programs=>IBM AS400 Client

Access Express=>Selective Setup.
__ 2. At the Selective Setup Options dialog box, click Source directory.
__ 3. Enter this path:

\\<server name>\QIBM\ProdData\NetworkStationV2\IBM.NSWizard
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and click Next. See Figure 5.

Note: If you received the error message, ″The install path specified is not
valid. Please specify a different path″, you may need to map a
network drive to your target server.

__ 4. At the Component Selection dialog box, expand the AS/400 Operations
Navigator component. See Figure 6.

__ 5. Click to place a check mark next to Network Station Setup Wizard and
click Next. Selective Setup will add the component for you.

__ 6. Follow the prompts until you are finished adding the component.

Figure 5. Client Access Express Selective Setup Options. Enter The Source Directory.

Figure 6. Client Access Express Selective Setup Component Selection. Select Network
Station Setup Wizard.
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Running the Network Station Setup Wizard
This section describes how to run the IBM Network Station Setup Wizard.

Attention
The IBM Network Station Setup Wizard will cycle off and on again the
following servers:
v TCP/IP
v TFTP
v HTTP
v DHCP
v Telnet.

Launch the Network Station Setup Wizard.
__ 1. Open the AS/400 Operations Navigator main window.
__ 2. Expand the view for your AS/400 system.
__ 3. If you receive an AS/400 Operations Navigator message to scan your target

server, click Scan Now.
__ 4. Expand the Network object.
__ 5. Right mouse click on IBM Network Stations and select Add Network

Stations to AS/400. See Figure 7 on page 21. This will launch the wizard.
__ 6. Follow the screens to complete the AS/400 Network Station Setup Wizard.

Use the online Planning Form and online help information for additional
support. Move your cursor into a field and press F1 for specific help.

__ 7. When you see the message ’Configuration and Verification Completed ... ’ in
the last line of the final wizard panel, click Close.
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To find out what the Network Station Setup Wizard does, see “What the Network
Station Setup Wizard does”.

What the Network Station Setup Wizard does
You should use the setup wizard to configure your AS/400 for use with Network
Stations.

Attention
The IBM Network Station Setup Wizard will cycle off and on again the
following servers:
v TCP/IP
v TFTP
v HTTP
v DHCP
v Telnet.

The wizard configures the AS/400 for IBM Network Stations. This includes
TCP/IP and either DHCP or BOOTP configuration. After successfully completing
the wizard, your Network Station will be able to start from this AS/400.

You may view a list of the functions the wizard will perform:
1. At the end of the wizard, you will see the AS/400 Network Station Setup

Summary panel. See Figure 8 on page 22.
2. On this panel, click the Details button. A Notepad viewer displays with a list

of what you have input to the wizard and the functions the wizard will
perform.

Figure 7. AS/400 Operations Navigator. Right-click on Add Network Station to AS/400.
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Note: The process speed will vary greatly depending on what you have asked the
wizard to do and your computer configuration.

The AS/400 Network Station Setup Wizard can (depending on your input):
v Set the host name for the AS/400
v Set the domain name for the AS/400
v Set the Domain Name Servers for the AS/400
v Set the TFTP server to autostart
v Set the DHCP server to autostart
v Set the HTTP server to autostart
v Set the Telnet server to autostart
v Start TCP/IP
v Set the HTTP server directives
v Create a new line
v Create a new TCP/IP interface
v Add gateways
v Adding routes
v Create a new network server description
v Add subnet to DHCP
v Exclude IP addresses from the subnet
v Set boot information
v Add static client IP addresses to the subnet
v Set the DHCP required global classes
v Start the Network Station login daemon

Figure 8. AS/400 Network Station Setup Summary

22 Installing IBM Network Station Manager for AS/400 V2R1



v Make the new line available
v Set your system to keep server security data
v Set the BOOTP server to not autostart
v Stop the BOOTP server
v Add host table entry for the interface
v Migrate the BOOTP server configuration to DHCP
v Make the network server available

After completing the wizard, you can use the AS/400 Operations Navigator to
review the configuration. See Figure 9 on page 24.
v Start an Operations Navigator session.
v In the left frame, expand your AS/400 server directory.
v Go to Network=>Servers=>TCP/IP.
v In the right frame, double-click on DHCP.
v In the left frame, highlight a subnet range. The Contents frame opens in the

upper right hand corner.
v In the Contents frame, highlight a class. The Options frame in the lower right

hand corner shows the options for that class.
v Notice the icons:

– Option tags 1, 3, 6, and 15 are in the subnet level.
– Tag 51 is in the global level.
– Tag 67 is in the class level.

Note: A PC or a printer (for example) will not have a class. They can have all
the options shown except option number 67.
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After completing the wizard, you can change the configuration with the AS/400
Operations Navigator.

To change the TCP/IP configuration, go to Network=>Protocols=>TCP/IP in the
Operations Navigator window.

To change the DHCP configuration, go to Network=>Servers=>TCP/IP=>DHCP in the
Operations Navigator window.

Depending on your system’s language, the Setup Wizard also adds some HTTP
directives. For more information about HTTP directives, see “HTTP directives” on
page 38.

Additional information for NVRAM
After you run the Network Station Setup Wizard:
v Go to each separate Network Station
v Use the Network Station Setup Utility or the NS Boot Utility to correctly

determine the values for your network.

For information on using these utilities, see the Using IBM Network Station Manager
book.

Additional information for BOOTP
In addition to running the Network Station Setup Wizard, for BOOTP see “Adding
BOOTP Network Stations with Operations Navigator” on page 27.

Figure 9. DHCP Configuration. Review the DHCP configuration with Operations Navigator.
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If you chose BOOTP during the Network Station Setup Wizard and you now want
to use the V2R1 boot path, you must change each Network Station individually.
See “Client migration” on page 47.

Diagnose and repair DHCP configuration errors
In the Network Station configuration for DHCP, if there is partial data or bad data,
you can find the suspected line through Operations Navigator:
1. Start a separate AS/400 Operations Navigator session.
2. In the left frame, expand your AS/400 server directory.
3. Open Network, Servers then TCP/IP.
4. In the right frame, right-click on DHCP and choose Configuration. The DHCP

Server Configuration dialog box appears.
5. If an error exists in the DHCP configuration file, you will see an Operations

Navigator error dialog box.
6. Take note of the line number where the error occurred and the specified file.
7. Select Ignore to see the same pop up for any other configuration error.
8. To edit the file in the message, use Operations Navigator’s Integrated File

System as follows:
a. In the left frame, expand File Systems. Right-click on Integrated File

System.
b. Choose Properties. Click on All files in the Allow edit menu option for:

field. Click OK.
c. From the error message, find the specified file under:

File Systems\Integrated File System\Root\<file path name>

d. Right-click the specified file and choose Edit.
e. Find the line that was defined as an error and fix.

Before you continue ...
Before you begin using your Network Stations, read and complete (when
applicable) each of the following items:

Updating boot code and boot monitor
To take advantage of new functionality, you must update the boot monitor on your
Network Stations. You may have Network Station machines with different levels of
boot monitor. Even if you have purchased new Network Stations, you should
verify and update the boot monitors of your Network Stations. For information
about updating boot monitors, see the Using IBM Network Station Manager book.

IBM Network Station login server
To allow V2R1 to run your Network Station network, you will need to stop the
V1R3 Network Station login server.

To stop the V1R3 Network Station login server, use the End TCP/IP Server
(ENDTCPSVR) command. At the AS/400 command line, type
CALL QYTC/QYTCUSVR ('ENDTCPSVR ')

Notice the space before the last quotation mark.

The IBM Network Station Setup Wizard starts the Network Station login server. If
you stop your TCP/IP or IPL your system, you must restart the Network Station
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login server. To start the V2R1 Network Station login server, use the Start TCP/IP
Server (STRTCPSVR) command. At the AS/400 command line, type
CALL QYTCV2/QYTCUSVR ('STRTCPSVR '). To stop the V2R1 Network Station login
server, type CALL QYTCV2/QYTCUSVR ('ENDTCPSVR '). Notice the space before the last
quotation mark.

DNS support
For series 300 and series 1000, if you use the BOOTP or NVRAM boot method, you
must enable DNS support through the Network Station Manager licensed program.
To enable DNS support, see the Using IBM Network Station Manager book.

Verify network parameters
Verify that the network parameters in the Setup Utility or the NS Boot Utility of
your Network Stations agree with your boot method. See the Using IBM Network
Station Manager book for more information about the Setup Utility or the NS Boot
Utility.

Verify that you started your:
v BOOTP or DHCP server
v NFS or TFTP server
v HTTP server.

Verify that you excluded any statically addressed devices in your DHCP address
range.

If you have a router between your Network Station and your boot server, verify
that your router can handle BOOTP and DHCP requests.

For more information about setting up Network Stations, see the Using IBM
Network Station Manager book.
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About this chapter
This chapter describes the functions that supplement the setup and configuration
of your Network Station environment.

After you have completed the Network Station Setup Wizard
How to configure your DHCP with both V1R3 and V2R1 environments running on
your network.
v For V2R1M0, the boot path for models S300 and S1000 is pointed at V2R1.
v For BOOTP table configurations, see “Adding BOOTP Network Stations with

Operations Navigator”
v For NVRAM memory settings, see the Using IBM Network Station Manager book

for more information about the Setup Utility or the NS Boot Utility.

Adding BOOTP Network Stations with Operations Navigator
This procedure adds Network Stations to an existing BOOTP environment.

Note: You need Operations Navigator (OS/400 V4R2 or later) to complete this
procedure.

__ 1. For each new Network Station, fill out a new row of information on Table 2
on page 28.

__ 2. Start an AS/400 Operations Navigator session.
__ 3. In the left frame, expand your AS/400 server directory.
__ 4. Open Network=>Servers=>TCP/IP.
__ 5. Double-click the BOOTP server.
__ 6. Click the Add button. See Figure 10 on page 28.
__ 7. Fill in the Network device information:

v Host Name

v MAC address

v IP address

v Hardware type

__ 8. Fill in the Network routing information:
v Gateway IP address. If you do not use gateway IP addresses for remote

local area networks (LANs), leave this field blank.
v Subnet mask. If you do not use a subnet mask for remote LANs, leave

this field blank.
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__ 9. Check the Boot information. Verify that the following default values are
correct:
v Type: IBM Network Station Manager

v Filename and directory: (8363-TXX and EXX)
/QIBM/ProdData/NetworkStationV2/X86/kernel.2200 (for series 2200
type-models 8363-TXX and 8363-EXX)

v Filename and directory: (8364-TXX and EXX)
/QIBM/ProdData/NetworkStationV2/X86/kernel.2800 (for series 2800
type-models 8364-TXX and 8364-EXX)

v Filename and directory: (NSM 1.1.0 and 2.1.0)
/QIBM/ProdData/NetworkStationV2/ppc/kernel.300 (for series 300
type-models 8361-110 and 8361-210)

v Filename and directory: (NSM A.2.0 and A.5.0)
/QIBM/ProdData/NetworkStationV2/ppc/kernel.1000 (for series 1000 type
8362)

__ 10. Click the OK button.
__ 11. Repeat steps 6 on page 27 through 10 for each additional Network Station.
__ 12. Click OK again to return to the Operations Navigator main window.

Table 2. BOOTP Network Station Information

Field Description Write Value Here

Host name The host name uniquely identifies your
AS/400 server in a TCP/IP network. In
Figure 4 on page 5, the host name for
one of the Network Stations is
ns1.mycompany.com.

Figure 10. Sample Configuration for a Network Station. Add a BOOTP client.
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Table 2. BOOTP Network Station Information (continued)

Field Description Write Value Here

MAC address A message authentication code (MAC)
address is a 12 digit number that
uniquely identifies each Network
Station, much like a serial number. The
MAC address can consist of both letters
and numbers (but not all numbers).
During manufacturing, the original MAC
address is hard coded in the Network
Stations. For Ethernet lines, specify a
hexadecimal value between:
020000000000 and 7EFFFFFFFFFF. For
Token Ring lines, specify a hexadecimal
value between: 400000000000 and
7FFFFFFFFFFF. The values must be 12
digits long. To find the MAC address,
see the chapter Working with MAC
addresses in Using IBM Network Station
Manager.

IP address Each Network Station requires a unique
IP address. In Figure 4 on page 5,
ns1.mycompany.com has an IP address
of 192.168.1.2. You should ensure the IP
address is valid for your organization
and that no other device in the network
uses it.

Hardware type Your Network Stations can attach to
either a Token-ring or an Ethernet LAN.

Gateway IP address
for remote LANs

If you do not use a gateway IP address
for remote LANs, disregard this field
and leave it blank in Operations
Navigator.

v If the LAN that you are attaching
Network Stations to is not directly
attached to your AS/400, it is referred
to as a remote LAN. You need to
specify the IP address of the IP
router/gateway that your Network
Station will use to reach the server.

v In Figure 4 on page 5, the gateway IP
address for Network Station
ns3.mycompany.com is 10.1.1.1.

Subnet mask for
remote LANs

If you do not use a gateway IP address
for remote LANs, disregard this field
and leave it blank in Operations
Navigator.

Boot Type The boot type is a constant. IBMNSM
identifies this network device as a
Network Station.

IBMNSM
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Table 2. BOOTP Network Station Information (continued)

Field Description Write Value Here

Boot File name and
directory

The boot file name is the name of the
file that the Network Station downloads
and uses to boot the remote device. The
value (the kernel) is a constant. The path
name is used to access the boot file on
the host. This value is always the same
depending on your hardware.

See notes below

Notes:

1. For IBM 8363-TXX and IBM 8363-EXX, the boot path is:
/QIBM/ProdData/NetworkStationV2/x86/kernel.2200 (for series 2200 type-models
8363-TXX and 8363-EXX)

2. For IBM 8364-TXX and IBM 8364-EXX, the boot path is:
/QIBM/ProdData/NetworkStationV2/x86/kernel.2800 (for series 2800 type-models
8364-TXX and 8364-EXX)

3. For IBMNSM 1.1.0 and IBMNSM 2.1.0, the boot path is:
/QIBM/ProdData/NetworkStationV2/ppc/kernel.300 (for series 300 type-models
8361-110 and 8361-210)

4. For IBMNSM A.2.0 and IBMNSM A.5.0, the boot path is:
/QIBM/ProdData/NetworkStationV2/ppc/kernel.1000 (for series 1000 type 8362)

Defining statically addressed Network Stations in a DHCP environment
A DHCP environment can support statically defined clients (Network Stations,
printers, PCs, and so forth). This is helpful when you want the DHCP server to
always assign a specific IP address to the client. With a statically defined client,
when the defined client requests an IP address from the server, the server always
returns the same IP address. Typically you will want to have DHCP dynamically
assign addresses to client workstations. However there may be times that you
want DHCP to assign a specific address to a workstation or device (for example,
network printer).

You can statically define a Network Station with the IBM Network Station Setup
Wizard. See “Running the Network Station Setup Wizard” on page 20.

You can also statically define a Network Station with Operations Navigator:
1. Start a separate AS/400 Operations Navigator session.
2. In the left frame, expand your AS/400 server directory.
3. Open Network=>Servers=>TCP/IP.
4. In the right frame, double-click on DHCP. The DHCP Server Configuration

dialog box appears.
5. In the left frame, right-click on the Subnet from which you would like to define

a static client. Choose New Client. The New Client Properties box appears.
6. On the General tab, fill in the Name and Unique Identifier fields.
7. Choose the IP Address tab. Click on the Assign IP Address button and fill in

the IP address you want to statically define. See Figure 11 on page 31.
8. Choose the Options tab. Select the options you require. At a minimum add the

following options:
v Option 1 Subnet mask
v Option 66 Server name
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v Option 67 Boot file name
v Option 211 Boot protocol

9. Click OK.

Migrating BOOTP Clients to a DHCP environment
You can migrate the BOOTP configuration to DHCP with the IBM Network Station
Setup Wizard. See “Running the Network Station Setup Wizard” on page 20.

DHCP can support BOOTP clients. If you want your existing BOOTP entries to
remain statically addressed (versus dynamically addressed), you can migrate them
into your DHCP environment. The migration program defines the BOOTP clients
as DHCP Clients. This change of service will not affect the BOOTP clients.

Attention
This migration will not migrate clients from V1R3 to V2R1. To migrate clients
from V1R3 to V2R1, see “Client migration” on page 47.

Configuring Printers on an AS/400

Note: Transforming print jobs requires OS/400 Version 4 Release 2 or later.
You can configure printers for your Network Stations with the IBM Network
Station Manager licensed program. A Network Station Manager application
generates a datastream. This datastream must match a datastream that your printer

Figure 11. Define New Client Properties. Assign a static address to a Network Station.
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understands. Using IBM Network Station Manager describes which datastreams the
Network Station Manager application produces. If your Network Station Manager
application does not produce a datastream that your printer understands, you
must send the print job to an AS/400 server. The AS/400 server transforms the
print job into the datastream of your choice. For example; Network Station A in
Figure 12 generates a print job from Netscape Communicator for Printer 1 (a
Printer Control Language (PCL) printer). The Network Station cannot send its print
job directly to the printer. Because Netscape Communicator can only generate
PostScript (PS) datastreams, the Network Station must send its print job to the
AS/400 server. The AS/400 server will transform the print job into a PCL
datastream. A queue on the AS/400 server then sends the transformed print job to
Printer 1.

For server-based applications, such as a 5250 session, you must configure a printer
on the server where the application is running. In this case, think of the Network
Station as only a window to the server. The server still performs the ″work″. For
example, in Figure 12 Network Station A is running a 5250 session on the AS/400
server. If you want to print to Printer 4, you must create a printer device
description on the AS/400 server. The AS/400 server will send the print job to
Printer 4. To create a printing device description on your AS/400 system, see “The
CRTDEVPRT command” on page 35.

Configuring Basic Printer Scenarios
Using Figure 12 as an example, Table 3 on page 33 explains the basic steps to
configure printers for your Network Stations.

Identify the scenario that best meets your needs and follow the steps to configure
your printers.

Figure 12. Possible Network Station Printing Scenarios

32 Installing IBM Network Station Manager for AS/400 V2R1



Table 3. Configuration Descriptions for Basic Printer Scenarios

Desired Print Scenario Print Job Flow in
Figure 12 on page 32

Configuration Instructions

Print from a Network
Station to a LAN printer

Network Station A to
Printer 4

1. In the Network Station Manager licensed program,
configure an entry in the Remote Printer Server field for
the LAN printer.

Print from a Network
Station to a LAN printer
with a different
datastream

Network Station A to
AS/400 server to Printer
1

1. On the server that will transform the print job, create a
printer device description and queue.

The printer device description must contain the IP
address or host name of the LAN printer. For more
information on configuring a printer device description,
see “The CRTDEVPRT command” on page 35.

2. In the Network Station Manager licensed program,
configure an entry in the Remote Printer Server field with
the IP address or host name of the transform server and
its queue name.

Print from a Network
Station to a locally
attached parallel printer

Network Station A to
Printer 6

1. In the Network Station Manager licensed program,
configure an entry in the Local Parallel Printer field.

Print from a Network
Station to a locally
attached printer with
different datastream

Network Station B to
AS/400 Server to Printer
5

1. On the server that will transform the print job, create a
printer device description and queue.

The printer device description must contain the IP
address or host name of the Network Station to which
the printer is attached. For more information on
configuring a printer device description, see “The
CRTDEVPRT command” on page 35.

2. In the Network Station Manager licensed program,
configure an entry in the Remote Printer Server field with
the IP address or host name of the transform server and
its queue name.

Print from a Network
Station to another
Network Station with an
attached parallel printer

Network Station B to
Network Station A to
Printer 6

1. In the Network Station Manager licensed program,
configure an entry in the Remote Printer Server field with
the IP address of the Network Station to which the
printer is attached. In the Queue name field, type
PARALLEL1.

Print from a Network
Station to another
Network Station with an
attached printer and a
different datastream

Network Station A to
AS/400 server to
Network Station B to
Printer 5

1. On the server that will transform the print job, create a
printer device description and queue.

The printer device description must contain the IP
address or host name of the Network Station to which
the printer is attached. For more information on
configuring a printer device description, see “The
CRTDEVPRT command” on page 35.

2. In the Network Station Manager licensed program,
configure an entry in the Remote Printer Server field with
the IP address or host name of the transform server and
its queue name.
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Table 3. Configuration Descriptions for Basic Printer Scenarios (continued)

Desired Print Scenario Print Job Flow in
Figure 12 on page 32

Configuration Instructions

Print from a Network
Station to a server
controlled printer

Network Station A to
AS/400 server to Printer
2 or 3

1. In the Network Station Manager licensed program,
configure an entry in the Remote Printer Server field with
the host name or IP address of the server that controls
the printer. In the Queue name field, enter the name of the
queue that controls the printer.

In this scenario, it does not matter if the datastreams do
not match. If you used the CRTDEVPRT command (as
specified in “The CRTDEVPRT command” on page 35),
the server will automatically transform the job if
necessary.

Printer Administration Techniques
Administrating a printer environment is a difficult task. You should create a printer
network diagram. Based on your diagram and printing needs, you should develop
a printing strategy. Under the right conditions, Network Stations can print to most
types of printers.
v One technique to consider is to have a server control the printers for your

Network Stations. In Figure 12 on page 32, the AS/400 server could control a
LAN printer like Printer 4. If Network Stations A and B always sent their print
jobs to the AS/400 server, the AS/400 server could control the flow of print jobs
to the printer. This scenario would reduce the work load on the Network
Stations when the printer’s buffer is full because the AS/400 would negotiate
print jobs with the printer. However, handling these print jobs may decrease the
performance of the central processing unit (CPU) in the AS/400 server
depending on the size and frequency of your print jobs. Your end users will
notice that it takes longer for them to receive their printouts. Also, since you
would send the print job from a Network Station to a server, then to a printer,
this technique would adversely increase network traffic.
To have a server control your Network Station printing is advantageous in an
environment with mixed printer datastreams. Since Network Station Manager
applications only generate certain datastreams, you may need to send print jobs
to a server. At the server the print job can be transformed into a datastream that
your printer understands. Depending on which application generates the job,
you may or may not need to transform your print jobs. This may require more
administration in the Network Station Manager licensed program and on the
server. Also, your end users would need to have a better understanding of
printing and networking. To eliminate confusion, you may consider sending all
print jobs to the server regardless of the need for job transformation. In the end,
you will have fewer printer entries in the Network Station Manager program
and fewer printer device descriptions on the server.

v The other technique is to set up your printing strategy so that your Network
Stations send their jobs directly to the printer. This strategy works whenever
datastream transformation is unnecessary. You can reduce printing time since the
print job goes directly to the printer. Your server will not bear the load of
controlling print jobs, and you perform less administration. Also, when you send
print jobs directly to the printer the chances are decreased that your server will
misinterpret your print job . When a server misinterprets a print job, the job may
become lost or damaged.
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The CRTDEVPRT command
The CRTDEVPRT command creates a printer device description on your AS/400
server.
__ 1. From an AS/400 command line, type CRTDEVPRT, and specify the following

parameters:
v Device description
v Device Class = *LAN
v Device Type = 3812
v Device Model= 1
v LAN attachment = *IP
v Activation Timer = 1-2550 seconds
v Inactivity Timer = 1-30 seconds, or *NOMAX
v Host Print Transform = *YES
v Image Configuration = Obtain a value from Table 4.
v Manufacturing/Type/Model = Press the F4 key and match value
v Remote Location = Name or IP address of the LAN attached printer(or

server) or IP address of a Network Station with an attached printer
v Port Number = TCP/IP port number that is used by printer

– 2501-IBM network printers
– 6464-printer attached to a Network Station
– 9100-most remaining network printers

v System Driver Program
– *NETSTNDRV for printers attached to Network Station
– *IBMPJLDRV for IBM network printers
– *HPPJLDRV for HP PJL-compatible printers attached directly to the

TCP/IP network

The AS/400 system automatically creates an output queue with the name of
the device description. For more information about AS/400 printing, see the
publication Printer Device Programming, SC41-5713.

__ 2. Activate the device.
v Type: WRKCFGSTS CFGTYPE(*DEV) CFGD(device description), and vary the

device on.
__ 3. Start a printer writer.

v Type: STRPRTWTR DEV(device description)

Table 4. Common Printers and Their Image Configuration Values. For more values, see the
publication Printer Device Programming, SC41-5713.

Image Configuration Value Printer

Compaq Pagemarc 20 *IMGD01

Epson EPCL-4 Printer *IMGA01

Epson EPCL-5 Printer *IMGA02

Epson Stylus Photo with PostScript *IMGB10

Epson Stylus Color 600, 800 with PostScript *IMGB11

HP Color Laserjet 5 *IMGA04

HP Color Laserjet 5M *IMGD04

HP Deskjet 560C, 820C, 1200C *IMGA04
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Table 4. Common Printers and Their Image Configuration Values (continued). For more
values, see the publication Printer Device Programming, SC41-5713.

Image Configuration Value Printer

HP Deskjet 500, 600, 1200 *IMGA01

HP Deskjet 1600C, 1600CN *IMGA04

HP Deskjet 1600CM *IMGD04

HP Laserjet II, IID, IIP *IMGA09

HP Laserjet II, IID, IIP with PostScript *IMGB01

HP Laserjet III, IIID, IIISi, 4L *IMGA01

HP Laserjet III, IIID, IIISi, 4L with PostScript *IMGD01

HP Laserjet 4, 4P, 4V, 4Si, 4 Plus *IMGA02

HP Laserjet 4M, 4MP, 4MV, 4Si MX, 4M Plus *IMGD02

HP Laserjet 5, 5P, 5Si *IMGA02

HP Laserjet 5M, 5MP, 5Si MX *IMGD02

HP Laserjet 6, 6P, 6L *IMGA02

HP Laserjet 6M, 6MP *IMGD02

IBM 3112, 3116 Page Printer with Intelligent Printer Data Stream
(IPDS) feature

*IMGD02

IBM 3112, 3116 Page Printer (ASCII/LAN) *IMGA02

IBM 3112, 3116 Page Printer with PostScript *IMGD02

IBM 3130, 3160-1 AF Printer (240-pel mode) *IMGC01

IBM 3130 AF Printer (300-pel mode) *IMGC02

IBM 3825, 3827, 3828 AF Printer *IMGC09

IBM 3825, 3827, 3828 AF Printer (with AFIG) *IMGC01

IBM 3829 AF Printer *IMGC01

IBM 3835-001 AF Printer *IMGC10

IBM 3835-001 AF Printer (with AFIG) *IMGC05

IBM 3835-002, 3900 AF Printer *IMGC05

IBM 3912, 3916 Page Printer (ASCII/LAN) *IMGA01

IBM 3912, 3916 Page Printer with IPDS feature (twinax) *IMGC06

IBM 3930-03 Page Printer *IMGA01

IBM 3930-03 Page Printer with PostScript *IMGD01

IBM 3935 AF Printer *IMGC02

IBM 4019 LaserPrinters (HP mode) *IMGA09

IBM 4019 LaserPrinters with PostScript *IMGB01

IBM 4028 LaserPrinters *IMGC06

IBM 4029 LaserPrinters *IMGA01

IBM 4029 LaserPrinters with PostScript *IMGB02

IBM 4039 LaserPrinters *IMGA01

IBM 4039 LaserPrinters with PostScript *IMGD07

IBM 4049 LaserPrinters *IMGA02

IBM 4049 LaserPrinters with PostScript *IMGD02
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Table 4. Common Printers and Their Image Configuration Values (continued). For more
values, see the publication Printer Device Programming, SC41-5713.

Image Configuration Value Printer

IBM 4079 Color Jetprinter PS *IMGB09

IBM 4303 Network Color Printer *IMGB05

IBM 4312, 4317, 4324 NP with IPDS feature (twinax) *IMGC06

IBM 4312, 4317, 4324 NP with IPDS feature (LAN) *IMGC06

IBM 4312, 4317, 4324 NP (ASCII/LAN) *IMGA02

IBM 4312, 4317, 4324 NP with PostScript (ASCII/LAN) *IMGD02

IBM InfoPrint 60 *IMGC03

IBM InfoPrint 62 Model 2 *IMGC05

IBM InfoPrint 62 Model 3 *IMGC06

IBM InfoColor 70 *IMGB05

IBM InfoPrint 4000 *IMGC05

IBM InfoPrint 4000 High Resolution *IMGC06

Lexmark 4039Plus *IMGB02

Lexmark Optra C Color Printer *IMGD11

Lexmark Optra E, E+ *IMGA02

Lexmark Optra N *IMGD02

Lexmark Optra R+, Rx+, Lx+, Lxn+ *IMGD02

Lexmark Optra S Printers *IMGD02

Lexmark Optra SC Color Printer *IMGD05

Okidata OL400 LED Page Printer *IMGA01

Okidata OL800, OL810 LED Page Printers *IMGA02

QMS 2025, 3225 *IMGB12

QMS Magicolor CX *IMGD04

Tektronix Phaser 140 *IMGB09

Tektronix Phaser 400 *IMGB05

Tektronix Phaser 300 *IMGB04

Tektronix Phaser 540, 550 *IMGB05

Tektronix Phaser 560 *IMGB06

Xerox 4219/MRP *IMGA01

Xerox 4220/MRP *IMGA02

Xerox 4230 DocuPrinter *IMGA02

Xerox 4512, 4517 Network Printer *IMGA02

Xerox 4520mp Printer *IMGB13

Xerox 4700 II Color Document Printer *IMGD04

Xerox 4915 Color Laser Printer *IMGB08

Xerox 4920, 4925 Color Laser Printer *IMGB05
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Optimizing your AS/400 server for Network Stations
By configuring some components of your TCP/IP, you can increase the network
performance of your Network Stations. The numbers listed below are
recommendations only. You may need to experiment with these values to optimize
your system.
__ 1. Increase your line description’s maximum frame size.

v For a token-ring line, type: CHGLINTRN LIND(YY) MAXFRAME(ZZ)

The value YY is the line description name, and ZZ is the maximum frame
size (recommended minimum size of 4096 for token-ring lines and 1496
for Ethernet lines).

v For an Ethernet line, type: CHGLINETH LIND(YY) and press the F4 key.
Scroll down and change the maximum frame size values to best fit your
system with a maximum value less than 1496.

__ 2. Enlarge the Send/Receive buffer sizes with the Change TCP/IP Attributes
(CHGTCPA) command.
Type: CHGTCPA TCPRCVBUF (64000) TCPSNDBUF (64000).

__ 3. Change TFTP Attributes
__ a. Type: CHGTFTPA and press F4. The Change TFTP Attributes screen

appears.

Change TFTP Attributes (CHGTFTPA)

Type choices, press Enter.

Autostart server . . . . . . . . *NO *YES, *NO, *SAME
Enable subnet broadcast . . . . *YES *YES, *NO, *SAME
Number of server jobs:

Minimum . . . . . . . . . . . > �X� 1-20, *SAME, *DFT
Maximum . . . . . . . . . . . > �Y� 1-250, *SAME, *DFT

Server inactivity timer . . . . 30 1-1440, *SAME, *DFT
ASCII single byte CCSID:

Coded character set identifier 00819 1-65532, *SAME, *DFT
Maximum block size . . . . . . . �YY� 512-65464, *SAME, *DFT
Connection response timeout . . 60 1-600, *SAME, *DFT
Allow file writes . . . . . . . *NONE *DFT, *NONE, *CREATE...
Alternate source directory . . . '*NONE'

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

__ b. Increase the number of TFTP jobs that are started on the host.
The value �X� is the minimum number, and �Y� is the maximum
number of server jobs. Determine the appropriate values for your
AS/400 server and network environment.

__ c. Set TFTP Maximum block size the same as the line description’s
maximum frame size.
The value �YY� is the same as value �ZZ� entered on step 1.

HTTP directives
When you used the IBM Network Station Setup Wizard to configure your Network
Station environment, it used a table similar to Table 5 on page 39 to configure your
HTTP directives.
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You may see garbled characters if you are using a web browser to access your
HTTP server. If so, use this section to verify that your HTTP directives are correct.

Table 5. Primary Languages and Their DefaultFsCcsid and DefaultNetCcsid Values

Language Primary Language
Value

DefaultFsCcsid
Value

DefaultNetCcsid
Value

Brazilian Portuguese 2980 37 819

Canadian French 2981 500 819

Danish 2926 277 819

Dutch Netherlands 2923 37 819

English Uppercase 2950 37 819

English Uppercase
and Lowercase

2924 37 819

English Uppercase
double-byte character
set (DBCS)

2938 37 819

English Uppercase
and Lowercase DBCS

2984 37 819

Finnish 2925 278 819

French 2928 297 819

French MNCS 2940 500 819

German 2929 273 819

German MNCS 2939 500 819

Italian 2932 280 819

Italian MNCS 2942 500 819

Norwegian 2933 277 819

Portuguese 2922 37 819

Portuguese MNCS 2996 500 819

Spanish 2931 284 819

Swedish 2937 278 819

v To view and change your HTTP directives on a V4R1 or later system, see “HTTP
directives for V4R1 and later systems”.

HTTP directives for V4R1 and later systems
__ 1. At an AS/400 command line, type WRKHTTPCFG.
__ 2. After the Work with HTTP Configuration screen appears, scroll down to

the entries that were added by the IBM Network Station Setup Wizard. The
following screen is an example of HTTP directives for a Swedish V4R1 or
later system.

02120 Map /networkstationv2/admin /QYTCV2/QYTCMAIN.PGM
02150 Exec /QYTCV2/* /QSYS.LIB/QYTCV2.LIB/*
02160 DefaultNetCcsid 00819
02170 DefaultFsCcsid 00278

__ 3. Verify that the DefaultNetCcsid and DefaultFsCcsid values match the values
in Table 5 for your language. If the values do not match or do not exist, add
the statements with the correct values.

__ 4. Verify that the following statements are also in your HTTP directives.
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Map /networkstationv2/admin /QYTCV2/QYTCMAIN.PGM
Pass /networkstationv2/* /QIBM/ProdData/HTTP/Protect/NetworkStationV2/*
Pass /flashconfigs/* /QIBM/UserData/NetworkStationV2/flash/ImageConfigs/*

If the statements are not in your directives, you must add them.
__ 5. At an AS/400 command line, type WRKHTTPCFG *ADMIN. Verify that the

following statements are in the directives for your HTTP ADMIN server.

Map /networkstationv2/admin /QYTCV2/QYTCMAIN.PGM
Pass /networkstationv2/* /QIBM/ProdData/HTTP/Protect/NetworkStationV2/*

If the statements are not in your directives, you must add them.
__ 6. At an AS/400 command line, type ENDTCPSVR *HTTP to end the HTTP server.

Then restart the HTTP server with STRTCPSVR *HTTP.

Trivial File Transfer Protocol (TFTP) subnet broadcast
When multiple Network Stations start up at the same time, they can create heavy
network usage, sometimes called boot storms. TFTP subnet broadcast (or broadcast
boot) is a solution to balancing your network traffic during these boot storms.

These boot storms occur because the AS/400 server is trying to deliver an
individual boot file to each Network Station. The server holds the boot file
download and distributes it only once to all Network Stations when:
v The TFTP subnet broadcast option is enabled, and
v Multiple Network Stations request their boot files.

You must enable the TFTP subnet broadcast option on both the AS/400 server and
the Network Stations. By default, the TFTP subnet broadcast option is enabled. To
verify this value type, CHGTFTPA at an AS/400 command line. The Enable Subnet
Broadcast value must be *YES.

Attention
Before you use TFTP subnet broadcast, you must verify or apply product
temporary fixes (PTFs).

Visit our IBM Network Station site at the following URL for the latest V2R1
information: http://www.ibm.com/nc.
1. In the left frame, click on Support.
2. In the Search field, enter ’PTF’ to show a list of required PTFs.

You should review this list to see the latest information and required PTFs
for every AS/400 server in your network. The application of these PTFs
prevents unpredictable results including possible data loss.

To enable the TFTP subnet broadcast (broadcast boot) option on the clients, use the
IBM Network Station Manager program. See the online help information for
assistance.

For more information about TFTP subnet broadcast, see the TCP/IP Configuration
and Reference manual, SC41-5420.
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Load balancing is another way to avoid boot storms. For more information on load
balancing, see IBM Network Station Advanced Information at
http://www.ibm.com/nc/pubs.
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Chapter 4. Migrating from V1R3 to V2R1
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About this chapter
This chapter provides instructions for migrating your preference files and your
existing Network Stations to V2R1.

These instructions are for migrating to V2R1:
v Your software release (migration utility), and
v Your existing hardware (client migration) if desired.

If you did not use the V1R3 migration utility and you manually changed
configuration files in the past, refer to the IBM Network Station Manager Advanced
Information publication. This book has more information for migration of these
user-edited configuration files.

You should read this entire chapter before you take any steps to migrate your files.
Preference file migration and client migration are complex processes. Do not try to
migrate your preference files without reading the sections below.

Migrating to the V2R1 environment
Migration will be initiated from an AS/400 command line. This migration utility
will enable the administrator to have their IBM Network Station Manager V1R3
configurations and users copied into the V2R1 environment. The V1R3 operating
environment remains unchanged. In addition to migrating configurations, the
utility directs the administrator to change his DHCP, BOOTP, or NVRAM
configurations so that the Network Station starts with the V2R1 software. The
administrator can perform this migration on a box-by-box basis or by vendor class
depending on the original Network Station configuration.

Both V2R1 and V1R3 can coexist and operate on the same server. When you install
V2R1 on a system that already has V1R3 installed on it, the V1R3 environment is
preserved. The ability for two software versions to coexist on the server allows
support for all Network Station hardware models. You can migrate configuration
information and user data from V1R3 to V2R1 with this migration utility. After you
migrate the configuration information and user data, you can uninstall (delete) the
V1R3 environment. Note that coexistence is not a requirement; either version can
stand alone on a server.

Because the V2R1 product can co-exist with the previous V1R3 product, removal of
the V1R3 product prior to installation of V2R1 is NOT required. If you use Series
100 or Series 300 Twinax models in your network, you need to continue to support
them with the V1R3 product. If these models are not present, you may choose to
remove the V1R3 product from the server. Or you can choose to isolate each
version to a separate server in the network. In any case, V1R3 is NOT a
prerequisite for V2R1.
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Migration considerations

You may need to consider the following items as you plan your migration:
v Before you can migrate from V1R3 to V2R1, you must install the latest PTFs on

V1R3. Please check Informational APAR II11759 for the latest list of OS/400 PTFs
at http://www.as400.ibm.com/clientaccess/ under the ″Information APARs″
link.

v If you have both the V1R3 and V2R1 environments on your server, then:
– You have two IBM Network Station Manager program interfaces. Each

interface has its own URL.
– You have two directory structures. You may need to reconfigure DHCP,

BOOTP, or NVRAM to point to the new environment. See “Client migration”
on page 47.

– You have two sets of configuration files. You may need to configure users in
both the V1R3 and V2R1 environments.

– The V2R1 Network Station login daemon supports both V2R1 and V1R3
environments.

– You should refer to V1R3 documentation for information about V1R3 and
V2R1 documentation for information about V2R1.

– Migration is one way (V1R3 to V2R1). Subsequent changes to the V2R1
environment cannot be migrated back to V1R3.

– After you run the migration utility, you can migrate V1R3 changes to V2R1 if
you re-run the utility. However, be aware that this may overlay any changes
that are made to V2R1 since the first migration.

Note: If you configure a V2R1 preference in V1R3, an overlay will occur.
However, if the V2R1 preference does not exist in the V1R3
configuration, it will most likely remain in the V2R1 files after
migration.

v You can only run the migration utility on the server.
v Languages and keyboards that were available in V1R3 may not be available in

V2R1.
v The text on buttons that were configured in V1R3 in a language that is not

supported in V2R1 may contain gibberish. If you detect this, you need to make
the changes manually.

Migration utility
The migration utility has the following requirements and features:
v Only persons with security officer authority can run this utility.
v While it is not necessary to have V1R3 installed, the utility will check to see if

the default userbase path is a valid V1R3 userbase structure.
v Migration from V1R3 to V2R1 is one way. Changes to configuration information

or user data in the V2R1 environment are not reflected in the V1R3 environment.
When you run the migration utility, changes to configuration information or user
data in the V1R3 environment can be reflected in the V2R1 environment .

v You can run the migration utility multiple times. Each time the migration utility
runs, it writes over any existing V2R1 configuration information and user data.

v You may run migration repeated times even against the same users, groups, or
Network Stations.
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v The migration utility does not include an option to delete the V1R3
environment. You must manually remove V1R3 and remove any left over
configuration files, if so desired.

Note: After you delete the V1R3 environment, you cannot run the migration
utility.

v Everything in your home directory in V1R3 is migrated over to V2R1.

Running the migration utility
For the latest V2R1 information go to http://www.pc.ibm.com/support/.
v In the left frame, click on Support.
v In the Search field, enter ’PTF’ to show the required product temporary fixes

(PTFs). You should review this list to see the latest information and required
PTFs for 5648-C07. The application of these PTFs prevents unpredictable results
including possible data loss.

To run the migration utility from a command line, type:
call pgm(qytcv2/qytcmumu) parm('<flag A>' <objectA1> <...> <object An>

'<flag B>' <objectB1> <...> <object bn>)

Note: All flags must have apostrophes around them.

Where <flag A> can be the -U, -G, -T flag. And <flag B> would be the next flag.

Breakdown of flags:

Note: The flags are not case sensitive.

Flag Description and Format

-A This flag is an *ALL option for the administrator to migrate everything (all
users, all groups, all terminals, and system preferences). Also, no other flag
should be entered.

-S This flag is specified to migrate the system configurations of V1R3 to V2R1.
No objects are after this flag.

-U This flag is used to migrate either particular users or all users. To migrate a
specific user, the username would be entered after the -U flag. You must
specify *ALL to get migration of all users.

-G This flag is used to migrate either particular groups or all groups. To migrate a
specific group, the groupname would be entered after the -G flag. You must
specify *ALL to get migration of all users.

-T This flag is used to migrate either particular Network Stations or all Network
Stations. The Network Station name would be entered after the -T flag. To
migrate a specific Network Station, the Network Station name would be
entered after the -T flag. The parameters to this flag should only contain the
name of the Network Station preference file (for example: ex.term1). For
instance, if the preference file is named after a MAC address, then you should
place this MAC address on the command line. The name of a Network Station
preference file can be a host name, an IP address or a message authentication
code (MAC) address. You must specify *ALL to get migration of all Network
Stations.

-C This flag is used to migrate systems with the Power PC version. This only
allows client migration to proceed. No objects are after this flag.
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-P This flag is not recommended unless running S/390 migration. Please refer to
S/390 documentation for more information. It is used to is allow a path other
than the default path (/QIBM/UserData/NetworkStation). This path needs to
point to the NetworkStation directory. This flag was created to allow migration
from an S/390 to an AS/400. So, if you are migrating from an S/390, you must
provide the mount point to the S/390 on the path flag. Single quotes are
required around the path. Please refer to the Series 390 migration
documentation for more information.

Example 1: call pgm(qytcv2/qytcmumu)
parm('-U' eddie john '-G' AdminGroup '-T' termname '-S' '-C') — where the utility will migrate
v users — eddie and john
v groups — AdminGroup
v terminals — termname
v system preferences,
v enable client migration (-C) and

Example 2: call pgm(qytcv2/qytcmumu) parm('-U'
*all '-G' AdminGroup) — where the utility will migrate ALL Network Station Manager users, user

Note: The -G flag, along will all other flags, should have apostrophes around it.

Example 3: call pgm(qytcv2/qytcmumu) parm('-A'
'-C') This migrates all V1R3 preferences.

Migrating specific files manually
You must manually migrate certain user files, if desired.

The V1R3 bookmarks.html and address-book.html files in your NAV directory will be
renamed to v1r3_bm.htm and v1r3_ab.htm. They will reside in the new V2R1
browser directory (QIBM/UserData/NetworkStationV2/home/<user>/.netscape). This
is due to the two default files already in place in the browser directory. If you
want to use your V1R3 bookmarks.html file information, import the information
from the browser as follows:
1. From the Netscape Communicator browser on a Network Station, click on

Bookmarks.
2. From the drop-down menu, choose Edit Bookmarks.
3. Choose File=>Import.
4. Select v1r3_bm.htm file at

QIBM/UserData/NetworkStationV2/home/<user>/.netscape and click OK.

If you want to use your V1R3 address-book.html file information, import the
information from the browser as follows:
1. From the NC Navigator browser on a Network Station, click on

Communicator.
2. From the drop-down menu, choose Address Book.
3. Choose File=>Import.
4. Select v1r3_ab.htm file at

QIBM/UserData/NetworkStationV2/home/<user>/.netscape and click OK.

Migrating Netscape mail.
1. Open a Netscape Communicator browser.
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2. Select Communicator => Messenger.
3. Click on Migrated Folders (these folders will contain ″??″ under column

’unread’).
4. Following is a list of conditions for this to work:
v You must install V2R1 on the same system that contained V1R3
v Only the series 300 and 1000 NVRAM Network Stations will get migrated to

V2R1
v This migration is all or nothing. If you would like to move certain Network

Stations back to V1R3, this you must do this manually. See page 47.
v You can do this migration only one time. You will not be able to run client

migration again.

Client migration
Client migration (which is for the hardware) is handled separately from software
migration (user preferences, configuration files). You will utilize client migration
where Network Station models that had been supported by the V1R3 product are
now also supported by the V2R1 product. Boot parameters such as path names
and protocols can and will be different in V2R1. Changes to the client
configuration are dependent on whether a specific Network Station is going to run
in the V1R3 or V2R1 environment. To see which release of IBM Network Station
Manager is required for your hardware, refer to Table 1 on page 10.

When you upgrade to V2R1, you need to migrate the following values:
v The file path
v The name of the boot code
v The boot file service

Note: Trivial file transfer protocol (tftp) is not available in V2R1. Therefore you
should replace tftp with rfs. For V2R1, tftp is only available as the boot
protocol for the kernel.

In the IBM Network Station Setup Wizard you had the option to migrate the
BOOTP configuration to DHCP. To migrate all the clients in the BOOTP table, you
must migrate all or nothing. Once the migration utility has run, you must
manually update the non-V2R1 entries in the BOOTP table as follows:

Note: If you have a number of entries to make, it may be handy to have a pad
and pencil for reference.

1. Start a separate AS/400 Operations Navigator session.
2. In the left frame, expand your AS/400 server directory.
3. Open Network, Servers then TCP/IP.
4. In the right frame, right-click on DHCP and choose Configuration. The DHCP

Server Configuration dialog box appears.
5. In the left frame, locate each Network Station class to migrate to the correct

boot path.
6. Highlight each class individually. In the lower right frame, double-click the

option 67 tag. The Class Properties dialog box appears.
7. Click on the Options tab and in the right frame, click on option 67. You will

see the File name (boot path) in the lower box.
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8. Enter the correct path name from the table below for each Network Station:

Class Boot Path

IBM 8363-EXX /QIBM/ProdData/NetworkStationV2/x86/kernel.2200 (for IBM
Network Station Ethernet)

IBM 8363-TXX /QIBM/ProdData/NetworkStationV2/x86/kernel.2200 (for IBM
Network Station Token-Ring)

IBM 8364-EXX /QIBM/ProdData/NetworkStationV2/x86/kernel.2800 (for IBM
Network Station Ethernet)

IBM 8364-TXX /QIBM/ProdData/NetworkStationV2/x86/kernel.2800 (for IBM
Network Station Token-Ring)

IBMNSM 1.1.0 /QIBM/ProdData/NetworkStationV2/ppc/kernel.300 (for Series
300 Token-Ring)

IBMNSM 2.1.0 /QIBM/ProdData/NetworkStationV2/ppc/kernel.300 (for Series
300 Ethernet)

IBMNSM A.2.0 /QIBM/ProdData/NetworkStationV2/ppc/kernel.1000 (for Series
1000 Ethernet

IBMNSM A.5.0 /QIBM/ProdData/NetworkStationV2/ppc/kernel.1000 (for Series
1000 Token-Ring)

9. Click OK.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
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programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Software Interoperability Coordinator
3605 Highway 52 N
Rochester, MN 55901-7829
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.
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Trademarks
The following terms are trademarks of International Business Machines
Corporation in the United States, or other countries, or both:

AIX MVS
Application System/400 NetView
AS/400 Network Station
Client Access On-Demand Server
DB2 OpenEdition
eNetwork Operating System/400
IBM OS/390
IBM Network Station OS/400
InfoColor RS/6000
Information Assistant S/390
InfoPrint System/390
IPDS VM/ESA
Micro Channel 400

Lotus is a trademark of Lotus Development Corporation in the United States and
other countries.

Tivoli is a trademark of Tivoli Systems Inc. in the United States and other
countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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